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5Welcome
Welcome to Eye Candy 4000! We hope you’ll
take the time to explore this manual; it
contains information to help you reap the
maximum benefit from these 23 filters.

Please read this opening section carefully;
it covers installation and basic features
common to all of the Eye Candy 4000
filters.   Take a few minutes to familiarize
yourself with the preview window, learn to
use the presets and create your own
settings, and you’ll quickly be ready to
dive in and experiment with the special
effects.

Upgrading from Eye Candy 3?

Be sure to spend time with the “For Users
Upgrading to Eye Candy 4000 from Eye
Candy 3” section starting on page 8.  You’ll
find plenty of information about the new
features we’ve added and changes we’ve
made to this latest version.

Important symbols:

  Pay close attention when you see
this symbol in the manual.   It marks the
presence of an important note or warning.

  The Happy Kitty symbol marks a
cool tip or useful suggestion.   Happy Kitty
wants you to enjoy using Eye Candy 4000.

Getting Started

Host Requirements:

Eye Candy is a plug-in; you must use it
with one of the following programs:

Macintosh
Adobe Photoshop 4.0 or later (includes
Photoshop 6)

Macromedia Fireworks 2 or later (all filters
work as “live effects” in Fireworks 3)

Adobe Image Ready 1.0 or later

Deneba Canvas 6.0 or later

Windows
Adobe Photoshop 4.0 or later (includes
Photoshop 6)

Macromedia Fireworks 2 or later (the filters
work as “live effects” in Fireworks 3)

Jasc Paint Shop Pro 5.0 or later

Corel Photo-Paint 8 or later

Deneba Canvas 6.0 or later

Adobe Image Ready 1.0 or later

  We are constantly testing new
programs for compatibility with Eye Candy.
For information about other host programs,
please check our Web site:
http://www.alienskin.com.
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System Requirements:

Macintosh
• PowerPC processor

• Macintosh System Software 8.6 or later

• at least 32 MB of physical RAM

• Color monitor with 24-bit video card

Windows
• Pentium II-class processor

• Windows 98/NT 4/2000/Me

• at least 32 MB of physical RAM

• Color monitor with 24-bit or greater video card

Macintosh Installation

Start by making sure you are not running your
graphics program (Photoshop, Fireworks, etc.).
This is necessary because these programs only
recognize new filters when starting up.

Insert the Eye Candy 4000 CD into your computer.
If you purchased an electronic version of Eye
Candy 4000, locate the Eye Candy 4000 installation
program that you downloaded from the online
store.   Double-click the “Install Eye Candy 4000”
icon.   After the splash screen, the installer will
display the license agreement for Eye Candy.   Click
Yes after you have read the agreement to agree
with its terms.   The installer will then display any
new information or changes to the installation
instructions.   After reading this, click Continue.

Next you will be asked to enter your name,
company name (optional) and registration code:

Your registration code is the 12-letter code
located on a sticker on the inside front cover of
the manual.  If you purchased an electronic version
of Eye Candy 4000, the 12-letter code, visible
during the download process, is included in the
email invoice or in an electronic users license file
with your download.   We strongly suggest you
store this code in a safe place for future installa-
tions.  We also recommend registering the software
with Alien Skin Software, either via our Web site or
by mailing us the registration card.  If you ever
need a replacement code, replacement software or
require technical support, you will need to be
registered with us.

After you enter your registration code, you will
see the main installation screen:

It is important that you now locate your graphics
program’s plug-in folder.   If you do not choose
the proper plug-in folder, then the filters will not
show up in your graphics program’s Filters menu.

Browse your hard disk until you find the appropri-
ate Plug-ins folder.   Highlight the folder and click
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the Install into...   button to return to the
main installation screen.   The Eye Candy
files will be copied to your hard disk.

If you are not sure where to install Eye
Candy, consult your graphics program’s
manual.   Photoshop users can check for
the plug-in location by selecting the Plug-
In option under the Preferences sub-menu
of Photoshop’s File menu.   The Plug-in
folder is usually located in the Photoshop
folder.

Rerun the installer if you wish to install
Eye Candy 4000 into other graphics
programs.  Lather.  Rinse.  Repeat.

Windows Installation

Start by making sure you are not running
your graphics program (Photoshop, Paint
Shop Pro, Photo-Paint, etc.).   This is
necessary because these programs only
recognize new filters when starting up.

Insert the Eye Candy 4000 CD into your
computer.  If you purchased an electronic
version of Eye Candy 4000, locate the Eye
Candy 4000 installation program that you
downloaded from the online store.   Run
the program “Setup.exe”.   After the splash
screen, the installer will display the license
agreement for Eye Candy.   Click Yes after
you have read the agreement to agree with
its terms.   The installer will then display
any new information or changes to the
installation instructions.   After reading
this, click Continue.

Next you will be asked to enter your name,
company name (optional) and your
registration code:

Your registration code is the 12-letter code
located on a sticker on the inside front
cover of the manual.  If you purchased an
electronic version of Eye Candy 4000, the
12-letter code, visible during the download
process, is included in the email invoice or
in an electronic users license file with your
download.   We strongly suggest you store
this code in a safe place for future installa-
tions.  We also recommend registering the
software with Alien Skin Software, either
via our Web site or by mailing us the
registration card.  If you ever need a
replacement code, replacement software or
require technical support, you will need to
be registered with us.

Next, our installer will quickly search for
all graphics programs on your computer
that are compatible with Eye Candy and
will display them in a list:
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Select one program (you can only install into one
graphics program at a time) and click OK.  The
installer will internally look for the correct plug-
ins folder for that selected program and install our
software there.

If you wish to install Eye Candy 4000 into a
program that’s not listed in the “Select Host” list,
click the Choose Another Location button to
bring up the manual “Select Destination Directory”
window.   Browse through the file list until you
find the desired folder and click OK.   If you are
not sure where to install Eye Candy 4000, consult
your graphics program’s manual.

Rerun the installer if you wish to install Eye Candy
4000 into other graphics programs.  Lather.  Rinse.
Repeat.

Registering Eye Candy 4000
Please take a moment to register your copy of Eye
Candy 4000 with us.  Note that if you purchased
Eye Candy 4000 directly from Alien Skin Soft-
ware, via phone, fax, email or the purchase
page at our Web site, then you are already
registered with us.  You only need to register if

you purchased Eye Candy 4000 through a catalog,
store or other reseller.  Registering will help speed
up any tech support assistance you may ever need,
and also allows us to let you know immediately of
any bug fixes or updates to the software.  We’ll
also be able to notify you of special discounts on
other Alien Skin products.

You can register via the World Wide Web during the
installation process (see the “Installation” section
starting on page 6).

If you don’t have access to the World Wide Web,
you can register by completing and mailing the
registration card included with every hard copy of
Eye Candy 4000.  Mailing the card is free in the
United States.

For Users Upgrading to Eye Candy
4000 from Eye Candy 3
This section lists only the new features we’ve added
to the package since version 3.  All of these
features are fully explained elsewhere in this
manual, either in the “User Interface” section
beginning on page 9 or in the relevant filter
descriptions beginning on page 20.

We have also made all of the Eye Candy 3 filters
faster and more powerful, and have added new
controls to each.

The Five New Filters

The following filters are new to Eye Candy:

Marble - easy, realistic marble textures (p. 52)

Wood – wood grain, rings, knots and more  (p. 78)

Drip – selections become dripping paintings
complete with 3D-like drops  (p. 34)

Melt – powerful distortions that mimic the effect
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Unlimited Undo/Redo
We have added an unlimited Undo and Redo
capability within the preview of each of
the filters.

Keyboard Shortcuts
Wherever possible, we have implemented
keyboard shortcuts identical to those used
in Photoshop.   See page 18 for the
complete list.

Menus from the Filter Window
We have added menus to the preview of
each filter; these are explained in the next
section.

Real-world Absolute Parameter units
You can now specify absolute units for
your Eye Candy settings in order to make
the effects resolution-independent.   See
the next section for more.

In-preview controls
We have added new controls inside the
preview window in Shadowlab and Star.
In-preview controls are explained in detail
in each of those two filter chapters.

The Eye Candy 4000 User
Interface

Menus

Command menus are accessible when you
call up each of the Eye Candy filters.
Macintosh users will see the menus in place
of their usual menu bar.   Windows users
will see the menus at the top of the filter
preview window.

Edit menu
This menu allows you an unlimited number
of Undo’s and Redo’s in the preview
window.  If you experiment with the

of heat applied to the selection  (p. 54)

Corona – easy solar flares, gaseous clouds
and other astronomical effects  (p. 30)

Where Are My Old Filters?

In a few cases, it made sense to combine
the functionality of two or three filters
into a single, more efficent version.  Rest
assured that no functionality has been
dropped as we’ve made the Eye Candy
filters easier than ever to use.

Drop Shadow and Perspective Shadow have
been combined into a filter called
Shadowlab (p. 58).

Inner Bevel, Outer Bevel and Carve have
been combined into a filter called Bevel
Boss (p. 22).

Glow is now called Gradient Glow (p. 46).

Powerful New Features

Bevel Profile Editor
A bevel profile editor is now included in
Bevel Boss, Chrome and Glass.  It is ex-
plained in detail in each of those filter
chapters.

Color Gradient Editor
A color gradient editor is now included in
Fire, Gradient Glow, Smoke and Star.  It is
explained in detail in each of those filter
chapters.

Seamless Tiling
Seamless tiling is now available in Fur, HSB
Noise, Jiggle, Marble, Swirl, Water Drops
and Wood.   For full info, see page 14.
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sliders, and find that you prefer a previous group
of settings, simply use the Undo command in the
Edit menu, or use Command-Z (Control-Z on
Windows machines) to back up as many times as
necessary.

The Edit menu also allows you to Copy, Cut, Paste
and Delete numerical values from parameter fields.

Filters menu
This menu allows you to switch between filters
from within the preview.   Some filters which
require a selection will be grayed out if no

selection has been made.   (Photoshop users note
that if you switch between filters from within the
Eye Candy preview, the Actions, History and Last
Filter Used functions will only record the filter
you pulled up first.)

View menu
This menu allows you to zoom in and out of the
preview, as well as view all of your image’s layers
in the preview window.

Settings menu
This menu allows you to name, save and delete

The Macintosh filter window (explanation on next page)

A
B C

E

D

F GH
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your own settings, as well as use the
presets that we included with each filter.
You can also reset a filter to its factory
default settings from this menu, or use the
F5 key.  For more on Settings, see the
“Using Settings” section on page 12.

Help menu
This menu allows you to access the Alien
Skin home page from within the preview.

The Filter Window

Take a look at the Macintosh Bevel Boss
filter window on the previous page.  In
addition to the filter window, the Eye
Candy menu bar will appear in place of
your usual Mac menu bar:

The Windows filter window looks almost
exactly the same, with the addition of the
Eye Candy menu bar at the top left:

A: The Slider Controls
Slider controls appear along the left side of
the filter window.  If an Eye Candy filter
has many controls, two or three tabs may
be present to help organize them.   The
tabs will be visible beneath the filter menu
list; click on a tab name to use its con-
trols.   One or more of the following tabs
may be present: Basic, Lighting, Color and
Bevel Profile.  Also, the Wood filter has
Knots and Grain tabs.

B: Thumbnail Navigation
The thumbnail image above the preview
window allows you to move the preview
anywhere in your image with a single
click.   The movable red box displays the
area of your image visible in the preview
window.

C: Move, Zoom and In-Preview Tools
The Move (hand) and Zoom (magnifying
glass) tools are found above the preview
window.   Click the hand to enable the
Move Tool, then click and drag to move the
preview image.

Click the magnifying glass to enable the
Zoom Tool.   Click to zoom into your
image; Option-click to zoom out (Alt-click
for Windows users).  Double-clicking the
Zoom Tool at any time resets the preview
window to 100% magnification.

Shadowlab and Star also include an In-
Preview (arrow) tool, at right below:

Clicking the arrow enables new controls
within the preview window.   See the
Shadowlab and Star chapters for more
information about In-Preview Controls.

D: OK and Cancel Controls
Clicking the “OK” button applies the filter
with the current settings.   Clicking
“Cancel” closes the filter window without
applying the effect.

E: Preview Window Area
Preview the effect on your image here.  The
preview area can be resized by clicking and
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you move the slider.   Most effects will probably
use the longer, left end of these sliders, with
values that change more gradually.

Note that you can use the slider, enter a numeric
value, or use the up and down arrow keys to
change the value of filter controls.

Using Settings

The Settings menu in each filter window allows
you to save and manage the presets that are
included with each filter.  You can also create your
own settings, and even trade them via email.

Note that the Bevel Profile and Color Gradient
Editors that are part of certain filters also have
their own lists of settings.   These are used and
traded in the same way as other settings.

How to load a preset
To use a preset included with a filter, simply open
the “Settings” menu and select the name of the
desired setting from the list.

How to Save and Manage Settings
If you have a filter setting you’d like to save for
later use, click “Save...” from the Settings menu.
A dialog box will appear to ask you to name the
setting.  Type in a name, using only letters and/or
numbers, and click “OK.”  The setting will appear
in the Settings menu immediately.

To rename a setting, click “Manage...” from the
Settings menu.   Highlight the setting you wish to
edit and click “Rename.”  Type in the new name
and click “OK.”

To delete a setting, click “Manage...” from the
Settings menu.   Highlight the setting you wish to
delete from the list and click “Delete.”

  You will not be able to “Undo” deleting a
setting.   Be certain you want to delete any setting

dragging the bottom right-hand corner of the
filter window.  Windows users can also click and
drag the bottom of the window.

F: Render Status Bar
The rectangle to the left of the magnification
indicator is the Render Status bar.   As an effect is
being rendered in the preview, this rectangle
displays the amount of rendering that has been
completed.

G: Magnification Indicator
The current level of magnification is shown to the
right of the render status bar at the lower right
corner of the filter window.

H: Mouseover Help String Area
All elements in each filter window have mouseover
help text associated with them.   This help text
will appear at the bottom left of the filter window
whenever you move your cursor over a user
interface element.

A Note About the Sliders
A variety of sliders are used in Eye Candy 4000.
Each one allows you to enter a numeric value or
click and drag the slider to get the desired effect.

Sliders like the one below use an intuitive 1 to 100
scale:

Sliders with length units as part of the slider name
are divided into two sections:

The shorter section at the right of the slider marks
an area of very high values that change rapidly as
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before doing so; the delete is permanent.

Resetting to Factory Default
Every filter has a basic factory default
setting.   The “Reset to factory default”
command in the Settings menu will display
a preview with the filter’s default setting.
This can be useful for those times when
bevels, color gradients or shadow manipu-
lations in the preview window have become
overly complex.   Using the F5 key will
also reset the current preview to the filter’s
factory default setting.

Trading Settings With Friends
Filter settings can be traded with other
users via email.   Settings can be traded
independent of the platform you are using
(Mac or Windows).   Settings are stored in
your graphics program’s Plug-ins folder, in
a folder called “Eye Candy 4000 Settings.”
Settings are organized by filter name.
“Eye Candy 4000 Settings” can be found in
your graphics program’s Plug-ins folder.
To trade a setting for the Marble filter, for
example, find that setting in the “Marble”
folder in the “Eye Candy 4000 Settings”
folder, attach it to an email and send.  The
person you’re emailing to must be using
Eye Candy 4000 in order to use the setting.

If you’re receiving a setting from someone
else, save it to the appropriate filter’s
folder in “Eye Candy 4000 Settings” and
that setting will appear the next time you
run that filter.  You do not have to restart
your graphics program to use a newly
installed setting.

Settings for the Bevel Profile and Color
Gradient editors, as well as the reflection
maps used in Chrome, can also be traded.
They are found in separate folders called
“Bevels,” “Gradients” and “Reflection
Maps.”

Restoring the Original List of Presets
If, after deleting or modifying the original
settings included with Eye Candy 4000, you
decide that you’d like to revert to them,
simply reinstall Eye Candy and the presets
will be restored.   If you have settings
you’d like to keep, save them to a location
other than the “Eye Candy 4000 Settings”
folder while you reinstall, and then move
them back after reinstallation is complete.

Real World Absolute Parameter
Units (Photoshop Only)

Many Eye Candy 4000 filter parameters are
now resolution-independent.   These
parameters are based on the measurement
unit (Inches, Centimeters, Picas, Pixels,
etc.) you specify in Photoshop.  This is
useful when you are making filter settings
while working on a mockup or sample
image at 72 dpi.   Now you can use those
same settings at a higher resolution for the
final image, without the need to recreate
them.   Our filters automatically use the
Photoshop Preference setting you choose
under File > Preferences > Units (in
Photoshop 6, this has been moved to Edit >
Preferences > Units).

  When experimenting with the filters,
we recommend you work with a 72 dpi
image.  If you find an effect that you like,
save it as a new setting.  If you then apply
it to a higher-resolution image, the effect
will look the same.

  If you are using the absolute unit
“pixels” as your units preference, then
your effect will look different at different
resolutions.  If Photoshop’s Units prefer-
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create a seamless tile and then fill the large area
with it.   Applying a texture filter (Swirl, for
example) to a large image can take a long time to
render.

How to Use Seamless Tiling in Photoshop
Create a rectangular selection (seamless tiling
doesn’t work with non-rectangular images).  Make
sure that the selection has pixels in it.  Marble and
Wood will fill the selection with the texture
regardless of what was there before, so the
contents of the selection isn’t relevant.  Fur, HSB
Noise, Jiggle, Swirl and Water Drops, however, will
use whatever pixels are in the selection to create
their effets; therefore, the success of the seamless
tiling depends on the original image.  For ex-
ample, a selection that has very different looking
edges (when comparing left and right, top and
bottom) will not tile well.  Use an image that has
edges that are relatively similar as your seamless
tile.

Here is an example of an image that will make a
good seamless tile:

And here is a seamless texture effect using the
Water Drops filter:

ence is set to “Percent,” our filters will default to
a unit of Pixels.  Also, each slider does have an
internal upper limit, so extreme slider values at a
low resolution may exceed the upper limit at a
higher resolution, rendering a slightly different
effect.

In graphics programs other than Photoshop, the
measurement unit is always “pixels.”

Seamless Tiling
A Seamless Tile option is available in the Fur, HSB
Noise, Jiggle, Marble, Swirl, Water Drops and Wood
filters.   Checking this box creates the effect in
such a way that it can be used to create back-
grounds and textures that have no visible seams.
Seamless tiles are often used in Web pages, 3-D
applications and desktop wallpaper.

Right: a seamless tile using the Swirl filter:

Below: the final seamlessly tiled texture effect:

  If you want to create a seamlessly tiled
texture effect in a large area, it will be much
quicker to apply the filter to a small selection,
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Here is an example of an image that won’t
work well as seamless tile.  Note the
dissimilar edges:

And here’s the proof, using the Water Drops
filter with Seamless Tile checked.  Note
that while the Water Drops are indeed
seamless, a seam is visible due to the edge
of the original image:

After making the selection, bring up one of
our texture filters and check the Seamless
Tile checkbox.  Adjust the sliders to
achieve the desired effect.  Apply the filter.

Next, choose Edit > Define Pattern from the
main Photoshop menu.  Select the area
that you wish to fill and choose Edit > Fill
> Pattern.  Click OK and the selection will
fill with a seamlessly tiled effect.

  The larger the initial selected tile,
the more variety you’ll see (of course,
larger tiles will take longer to render).

Getting The Most From Eye
Candy 4000
This section offers important information
about using the Eye Candy 4000 filters with
Selections, Layers and Actions.

Using Selections

Most paint programs have powerful selec-
tion capabilities; we have tried to build on
these features by taking selection shape
into account when designing our filters.
Using selections will almost always give
you the maximum benefit from Eye Candy
4000’s filters.   Also, be sure to read the
chapter on Selections in your Photoshop
manual.

All of the filters in Eye Candy 4000 that use
selections will also work on objects in
layers with no selection.   Working with an
object on its own layer is usually much easier
than creating a selection.   It also has the
advantage of allowing you to move the
affected area after the filter has been
applied.   See the next section on Layers
for more information about this option.

  We strongly recommend that,
whenever possible, you apply filters to
elements in a layer without using the
selection tool.   We have found that the
selection tool used in most hosts will leave
a visible fringe around the selection; this
fringe may be visible after you apply some
of our filters.   For example, if you create
green type with Photoshop’s Type tool and
than apply our Marble filter, you may see a
green fringe around the Marble effect.   To
avoid this problem, don’t use a selection
tool; instead, simply apply the filter to the
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type (or other element) in its own layer.

If you want to apply a filter to only a small part of
a layer and must use the selection tool, we
recommend that you expand the selection by a few
pixels before applying the filter.   This should
eliminate the “fringe” trouble caused by the host
program’s selection tool.

Using Layers

A layer is like an extra image on a piece of clear
glass over your background image.   Layers allow
you to keep your composition flexible until you’re
sure where you want to place all of your image
components.   Most of Eye Candy 4000’s filters take
advantage of this layer technology.   For more
information about Photoshop’s layer capabilities,
consult your Photoshop manual.

All of our filters can be used in layers.   More
importantly, many Eye Candy 4000 filters actually
affect transparency when used in a layer.   This
means, for instance, that you can use Shadowlab to
create a subtle perspective shadow around type in
a layer, then move type and shadow together
without affecting the rest of your image.

“Show All Layers” in Photoshop and ImageReady
Due to a limitation in Photoshop, choosing ‘Show
All Layers’ in the preview window will show all of
the visible layers in your image, even if those
layers are above the current layer in the Layers
palette.

In the preview, you will also see the current layer
you are working on below the filter effect.  For
example, if you are using Jiggle on type in a layer,
you’ll see all the unaffected type layer below the
effect itself, as shown in the following preview
image:

Again, this is a limitation in Photoshop, not Eye
Candy, but it can be misleading so we recommend
temporarily turning ‘Show All Layers’ off when
using the following filters: HSB Noise, Jiggle,
Weave, Cutout, Melt and Drip.

  Show All Layers will be grayed out and
unavailable in hosts other than Photoshop.

“Preserve Transparency” in Photoshop
The Eye Candy 4000 filters will behave unpredict-
ably or have no effect when Preserve Transparency
is enabled.   Note that Photoshop 4 automatically
enables Preserve Transparency when it creates type
and when it places an image in a layer.   Disable it
and you will be able to use our filters without a
problem.   Unfortunately, a filter only has access
to one layer at a time.   That means that when you
work with a floating selection or a layer, the
preview will not be able to show you the entire
image composition.   Wherever the layer is
transparent, the preview will show a checkerboard
pattern.

  One final note about layers, selections and
our filters:  Remember that if you are working
with an object in its own layer, you don’t need a
selection at all, because the filter can figure out
the shape of your object by looking at which parts
of the layer are opaque.

Photoshop 5’s Type Layer and Eye Candy 4000
Adobe Photoshop 5 allows users to create a special
dynamic kind of layer.   While working with a type
layer, you will notice that all of the Filters are
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grayed out.   In order to use filters on
those layers, you will need to first render
the layer.   Rendering the layer will
convert the type to pixels.   To render the
layer, select the type layer and choose
Type>Render Layer from the Layer menu.
After rendering a type layer, you will be
able to apply our filters, but the type will
no longer be editable (this is built into
Photoshop 5).

(This issue has been addressed in
Photoshop 5.5 and Photoshop 6.0.)

Eye Candy 4000 and Actions In
Photoshop

Photoshop 4.0 introduced the ability to
group a series of tasks into a single
automated command, or Action.   Eye
Candy 4000’s filters were designed to take
advantage of this powerful new feature.
For more information about how to use
Actions, consult your Photoshop manual.

  We’ve included some useful Actions
(such as an automated Seamless Tile
Texture Fill and Drop Shadow on a Layer)
on the Eye Candy 4000 CD-ROM in a folder
called “Actions.”  These Actions are also
available at our Web site:
http://www.alienskin.com.

Live Effects
A few graphics programs have added the
ability to apply Eye Candy 4000 filters as
dynamic or live effects.  Currently,
Macromedia Fireworks 3.0 and Deneba
Canvas 6.0 have this feature.  Applying a
filter as a “live effect” means that a user
can apply our filters to artwork in such a
way that whenever the artwork is revised

the filters will automatically update to
match the revision.   The applied effects are
also completely editable, and favorite
settings can be saved and applied to other
objects.

This is very useful for creating dynamic
documents edited to suit various needs.
For example, let’s say you’ve created some
type and applied Bevel Boss and Shadowlab
to it.

Suppose, however, that you’ve misspelled
the word.  Since our filters were applied as
“live effects”, you can simply replace the
letter in question and watch as our filters
are automatically updated to reflect the
change.  In other words, you do not have
to reapply the filters to the new text in
order to see the change:

“Live effects” also allow you to edit any
filter’s parameters at any time.  For
example, you can adjust the Bevel Boss
Width and Highlight Direction as well as
the Shadowlab Direction settings, and the
artwork will automatically adjust:



  For more information about how to use live
effects in a specific graphics program, refer to the
programs user manual or visit Alien Skin’s Web
site: http://www.alienskin.com.

Enjoy the Filters!

That’s it for the opening section.  We’ve designed
Eye Candy 4000 to be a tool that’s fun and easy to
use; we hope you enjoy using these 23 filters.

Keyboard Shortcuts

Here is a list of keyboard shortcuts used in Eye Candy 4000:

Macintosh Windows
Next Slider Field Tab Tab
Previous Slider Field Shift + Tab Shift + Tab
OK Return Return
Cancel Escape Escape
Undo Command-Z Control-Z
Redo Command-Y Control-Y
Cut Command-X Control-X
Copy Command-C Control-C
Paste Command-V Control-V
Next Filter Command- ] Control- ]
Previous Filter Command- [ Control- [
Zoom In Command- ‘+’ Control- ‘+’
Zoom Out Command- ‘-’ Control- ‘-’
Actual Pixels Command-zero Control-zero
Restore Default Settings Command-R F5
Enable Move (hand) H H
Enable Zoom Z Z
Enable In-Preview A A
Zoom In Mouse Click Mouse Click
Zoom Out Option + Mouse Click Alt + Mouse Click
Zoom to Actual Pixels Double-click Zoom Tool Double-click Zoom Tool
Increase/Decrease Slider Value by 1 Up/Down Arrow Up/Down Arrow
Increase/Decrease Slider Value by 10 Shift-Up/Down Arrow Shift-Up/Down Arrow
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Antimatter

The Antimatter filter inverts a selection’s
brightness without affecting hue and
saturation values.  This is useful for creating
a contrast effect while retaining the current
colors.  Antimatter is a quick and easy way
to invert a graphic for a javascript
mouseover image, for example.

Controls

Invert Brightness
Controls the amount the brightness of the
colors will be inverted.  A value of zero
produces no inversion at all; a value of 100
inverts the brightness completely.

Decrease Saturation
This slider reduces the saturation of colors
in bright areas of your selection after the
colors are inverted.   Decrease Saturation is
particularly useful on JPEG images which
have been highly compressed.  The compres-
sion often introduces some odd color
artifacts which Antimatter will exaggerate.
Decrease Saturation can tone those artifacts
down.

  See page 92, or the PDF manual
included on your Eye Candy 4000 CD, for
color examples of Antimatter at work.



21  Apply Antimatter to one (rather
than all) of your image’s RGB or CMYK color
channels to create vibrant color effects.

Above: an RGB image in glorious Grayscale.  See page
92 for the color version of this example.

Above: Antimatter applied to all three color channels;
brightness has been inverted in all three channels.
By selecting and applying Antimatter to just the
Green channel, we have a more dramatic color effect.

Above: original, compressed JPEG image.

Antimatter was applied with a high Invert Brightness
value.  There are odd artifacts in the middle of the
pupil, caused by the high compression of the original
JPEG.

Using a Decrease Saturation value of 50 minimizes
the artifacts, yielding a more consistent Antimatter
effect.
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Bevel Boss

The Bevel Boss filter creates an enormous
variety of bevel and carve shapes.   You can
add an embossed look to any selection,
either inside or outside the selection edges -
- perfect for quickly creating “buttons” of
any shape.  You can also use Bevel Boss to
create a chiselled effect.

Controls

Bevel Width
Controls the width of the bevel at the
selection edge.  Higher values produce a
wider bevel.   See “A” in the diagram below.

Bevel Height Scale
Controls the amount the bevel will swell out
from the page.   Higher values will  increase
the harshness of shadows.  See “B” below.

(The dotted line represents the selection)
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Smoothness
Controls how smooth or ridged your bevel
will appear.  Higher values produce a more
rounded bevel.

Bevel Placement
Clicking “Inside Selection” means your
bevel will appear inside the selection.
Click “Outside Selection” if you want the
bevel to affect the area outside the edge of
the selection.

Darken Deep Areas
This slider darkens low-lying areas of the
bevel.  It’s useful for creating and empha-
sizing carve effects.

Shade Interior
Clicking this box will darken the non-
bevelled portions of your selection.

Lighting Tab

Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Inclination
Controls the angle formed between the
light and the page.  Click and drag within
the lighting control box to change the
inclination, or enter a numerical value
between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;
higher values increase the intensity.

Highlight Size
Controls the size of the shiny highlights
appearing on areas facing the light; higher

values yield larger highlights.

Highlight Color
Choose any color for the shiny highlights
added to the bevel.   Clicking the left box
pulls up the color picker you’ve chosen in
your graphics program.   Clicking one of
the next two boxes pulls up your previ-
ously chosen foreground or background
color.  Clicking the eyedropper tool allows
you to choose any color inside the preview
image by clicking on it.

Shadow Color
Controls the color of the shadows in the
bevel or carve effect.   See Highlight Color.

Bevel Profile Tab

This tab gives you direct control over the
shape of the bevel, as seen from a side
profile.   It includes a list of saved profiles,
a profile editing window and a“Sharp
corner” box, as seen below.

Using the list of saved bevel profiles
The bevel profile editor comes with a set of
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saved profiles for you to experiment with.   We
recommend that you examine the profiles included
in the list to see how they affect a preview image.

You can create and save your own bevel profiles.
To add a profile to the list, just click the “Add”
button.   You will be asked to name the current
bevel profile.   Click “OK” and the new profile will
now appear whenever you open the bevel profile
editor in this filter.

To rename a profile, click the “Rename” button.

To delete a profile from the list, click the “Delete”
button.

  The “Undo” feature will not work after
adding, renaming or deleting bevel profiles.   Once
you delete a bevel profile, it’s gone for good, so be
sure you want to delete it before actually doing
so.

Shaping the bevel profile
Below the list of profile names is the current bevel
profile.   Shape the bevel by clicking anywhere
along the profile to add a new control point and
then drag it to create the desired shape.   The
editor will draw the simplest curve that fits the
points you’ve added.

To remove a control point from the bevel profile,
click to highlight it and then click the “Remove”
button, or just drag the point out of the bevel
profile box.   Removing control points will
simplify a bevel profile.

Sharp Corner
Clicking this box changes the profile shape at the
highlighted control point.   Each control point can
create either a smooth curve or a sharp corner.

Following are examples of bevel profiles and the
resulting images they create.  All settings have
been kept constant in these examples except for
changes to the bevel profile.

A few changes to the bevel profile produces a
dramatically different effect on the same selection:

Example #3 below is the same as #2 above except
for the use of the “sharp corner” checkbox on the
second control point from the left:



25

  You can trade bevel profiles via
email with your friends!  See the “Settings”
section on page 12 for information about
trading bevel profiles.

Creating an Outer Bevel
Checking the “Outside Selection” option in
the Bevel Placement box yields a bevel
drawn using color information from the
area outside of the selection, in this case,
the white background:

Note that when Inside Selection is checked,
the left side of the Bevel Editor is the

inside edge of the bevel  When Outside
Selection is checked, the right side of the
Bevel Editor is the outside edge of the bevel

Creating a Carve Effect
As you can see from parts of the examples
on these two pages, a left-to-right down-
ward curve in the profile editor produces a
raised bevel, and a left-to-right upward
curve produces a carved or chiselled effect.
Below is an example of a carve effect using
the “Basic Carve” setting included with
Bevel Boss:

As noted on page 25, using the “Darken
Deep Areas” slider can help create a more
pronounced carve effect.

  If you ever feel the current bevel
profile has gotten too complex, remember
that hitting the F5 key will reset the filter
to a simple factory default setting.  Also,
don’t forget that you have unlimited
“Undo” capablities from the Edit Menu, or
by using the Control-Z keyboard shorcut.
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Chrome

The Chrome filter uses reflection maps to
create a wide range of realistic metallic
effects, including gold, silver, copper and
other metals.

Reflection maps are uncompressed TIFF files
that are warped around your selection to
create the reflections similar to those seen
on actual metal objects.   We have included
a variety of reflection maps with Chrome.

  Chrome works with images in RGB or
Grayscale mode only.

Controls

Reflection Map
Choose an uncompressed TIFF image which
will be used as the current reflection map.
If you’d like to add your own reflection map
to the list, close your graphics program and
save a copy of the uncompressed TIFF file (in
RGB mode) to the “ReflectionMaps” folder in
the “Eye Candy 4000 Settings” folder.   Your
map  will appear in the list the next time
you use Chrome.  If you’d like to delete a
map from the list, simply delete the file
from the “ReflectionMaps” folder.

  You can create and save your own
reflection maps for use in Chrome.   Any
uncompressed TIFF file saved in RGB mode
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will work.  TIFF images that are compressed
or in color modes other than RGB will NOT
load as reflection maps in Chrome. We
recommend images of a landscape with a
definite ground and sky,  or interiors with
a floor, walls and windows visible.  These
images tend to make the best reflection
maps.  We’ve also found that a file with
dimensions of about 72 x 72 pixels creates
a softer, more realistic reflection map.

Bevel Width
Controls the width of the bevel at the
selection edge; higher values yield a wider
bevel and shrink the raised area of the
selection.

Bevel Height Scale
Controls the amount the selection appears
to swell out of the screen.   Higher values
will make the bevel effect more pronounced
by darkening shadows, which makes the
bevel appear steeper.

Smoothness
Controls the amount the ridges in the bevel
are smoothed away.   Higher values produce
a smoother, less ridged bevel.

Ripple Thickness
Controls the thickness of lumpy imperfec-
tions in the surface of the Chrome effect.
Higher values produce a stronger, more
rippled effect.

Ripple Width
Controls the width of lumpy imperfections
in the surface.   Higher values yield wider
ripples.

Bevel Placement
Controls whether the bevel is drawn inside
or outside the selection.   Note that if you
are using this filter on an entire layer, this
control will be grayed out and unavailable.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Lighting Tab

Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Inclination
Controls the angle formed between the
light and the page.  Click and drag within
the lighting control box to change the
inclination, or enter a numerical value
between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;
higher values increase the intensity.

Highlight Size
Controls the size of the shiny highlights
appearing on areas facing the light; higher
values yield larger highlights.

Highlight Color
Choose any color for the shiny highlights
added to the bevel.   Clicking the left box
pulls up the color picker you’ve chosen in
your graphics program.   Clicking one of
the next two boxes pulls up your previ-
ously chosen foreground or background
color.  Clicking the eyedropper tool allows
you to choose any color inside the preview
image by clicking on it.
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Bevel Profile Tab

This tab gives you direct control over the shape of
the bevel, as seen from a side profile.   It includes
a list of saved profiles, a profile editing window
and a“Sharp corner” box, as seen below.

Using the list of saved bevel profiles
The bevel profile editor comes with a set of saved
profiles for you to experiment with.   We recom-
mend that you examine the profiles included in
the list to see how they affect a preview image.

You can create and save your own bevel profiles.
To add a profile to the list, just click the “Add”
button.   You will be asked to name the current
bevel profile.   Click “OK” and the new profile will
now appear whenever you open the bevel profile
editor in this filter.

To rename a profile, click the “Rename” button.

To delete a profile from the list, click the “Delete”
button.

  The “Undo” feature will not work after
adding, renaming or deleting bevel profiles.   Once
you delete a bevel profile, it’s gone for good, so be

sure you want to delete it before actually doing
so.

Shaping the bevel profile
Below the list of profile names is the current bevel
profile.   Shape the bevel by clicking anywhere
along the profile to add a new control point and
then drag it to create the desired shape.   The
editor will draw the simplest curve that fits the
points you’ve added.

To remove a control point from the bevel profile,
click to highlight it and then click the “Remove”
button, or just drag the point out of the bevel
profile box.   Removing control points will
simplify a bevel profile.

Sharp Corner
Clicking this box changes the profile shape at the
highlighted control point.   Each control point can
create either a smooth curve or a sharp corner.

  If you ever feel the current bevel profile has
gotten too complex, remember that hitting the F5
key will reset the filter to a simple factory default
setting.  Also, don’t forget that you have unlimited
“Undo” capablities from the Edit Menu, or by using
the Control-Z keyboard shorcut.

For detailed examples of different bevel profiles
and their effects on an image, see pages 24-25 in
the Bevel Boss filter chapter.

Chrome and the Bevel Profile

The chrome effect is added based on the bevel
profile you have chosen.  This means that very low
points along the bottom of the bevel profile will
not display any chrome effect.  This is demon-
strated with the examples on the next page.
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A standard bevel profile:

The corresponding chrome effect:

A more complex bevel, with two low
points:

The corresponding chrome effect:

  Take the time to experiment with
different bevel profiles using Chrome.

You can create metallic text in seconds; here, a high
Ripple Thickness, Smoothness and Bevel Height Scale
creates the desired effect.
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Corona

The Corona filter quickly creates solar flares,
gaseous clouds and other astronomical
effects.

  This filter requires a selection if you
are using it on a background layer.

Controls

Glow Width
Controls the distance the corona extends
from the selection

Flare Size
Controls the width of the colored flares.
Higher values yield wider flares.

Stretch
Controls the amount the flares are
elongated.   Higher values yield longer
flares.

Waver
Controls the amount the flares are bent.
Higher values yield more obviously bent
flares.

Blur
Controls the amount of softening of harsh
edges.   Higher values yield a softer effect.

Overall Opacity
Controls the opacity of the entire effect.
Low values yield a more transparent effect.
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Color
You can choose any color for the corona.
Clicking the left box pulls up the color
picker you’ve chosen in your graphics
program.   Clicking one of the next two
boxes pulls up your previously chosen
foreground or background color.  Clicking
the eyedropper tool allows you to choose
any color inside the preview image by
clicking on it.

Draw Only Outside Selection
When checked, the corona will appear only
outside the selection.

Radiate from the Selection
When checked, the corona will originate
along the selection edge; when unchecked,
the effect radiates from the center of the
selection.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

The Stretch and Waver sliders can be used together to
produce a wide variety of gaseous effects:
1) low Stretch, low Waver
2) low Stretch, high Waver
3) high Stretch, high Waver
4) high Stretch, low Waver

Corona applied with the Radiate from the Selection
box unchecked.  Note the effect clearly radiates from
the center of the word.

Here, Corona was applied with Radiate from the
Selection checked and all other controls held
constant.  Note how the effect originates along both
the inside and outside edges of each letter, for a very
different look.
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Cutout

The Cutout filter makes your selection
appear as a hole in the image by adding
shadows, and also allows you to control
what is seen through the cutout effect

Controls

Direction
Controls the direction the shadow falls from
the edge of the selection.   Use the visual
control or enter a numeric value between 0
and 360 degrees.

Distance
Controls the distance the shadow falls from
the edge of the selection.   Higher values
create the appearance of a deeper cutout.

Blur
Controls the amount of blurring of the
shadow.   Higher values yield a blurrier
shadow, implying a light source that is
softer or farther away.

Opacity
Controls the opacity of the entire shadow.
Higher values yield a more opaque effect.

Shadow Color
Choose any color for the shadow.   Clicking
the left box pulls up the color picker you’ve
chosen in your graphics program.   Cicking
one of the next two boxes pulls up your
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previously chosen foreground or back-
ground color.  Clicking the eyedropper tool
allows you to choose any color inside the
preview image by clicking on it.

Inside Fill
You have a choice as to what is visible
through the Cutout effect.

Fill with solid color - clicking here enables
the color picker, which allows you to
choose any color to fill the Cutout.

Keep original image - clicking here leaves
the original selection visible through the
Cutout.

Make selection transparent - clicking here
leaves the selection transparent, leaving
underlying layers visible through the
Cutout effect.

  If you are working on a background
layer, the “Make selection transparent”
option will be grayed out and unavailable.

Examples of the three choices for the Inside Fill.  Top
left: “Fill with solid color,” using green.  Bottom left:
“Keep original Image” adds shadows only.   Right:
“Make Selection Transparent makes underlying layers

visible.

Fun “peek-a-boo” effects are easy with Cutout; a
selection is made in the desired shape and then
Cutout is applied to the solid layer above the puppy.

Softer effects are created with high Distance and Blur
settings.
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Drip

The Drip filter instantly turns text and
images into dripping paintings with 3D-like
drops.

  This filter requires a selection if you
are using it on a background layer.

Controls

Width
Controls the width of the drips.   Higher
values yield fewer, wider drips.

Maximum Length
Controls the length of the longest drips.
Other drips may be drawn with shorter
lengths.

Spacing
Controls the approximate horizontal
distance between the drips.   Higher values
yield drips that are farther apart.

Taper
Controls the amount the drip thins as it
flows down.   Higher values yield more
thinning.

Dribble
Controls the amount of variation in drip
thickness.   Higher values yield more
variation and broken-up dripping.
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Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Lighting Tab

Lighting Strength
Controls the intensity of the three-dimen-
sional lighting effects.   Higher values yield
a more obvious 3-D effect.

Lighting Coverage
Controls the amount of area of each drip
that will appear three-dimensional.
Higher values yield a more obvious 3-D
effect.

Lighting Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Lighting Inclination
Controls the angle formed between the
light and the page.  Click and drag within
the lighting control box to change the
inclination, or enter a numerical value
between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;
higher values increase the intensity.

Highlight Size
Controls the size of the shiny highlights
appearing on areas facing the light; higher
values yield larger highlights.

Highlight Color
Controls the color of any shiny highlights
added to your droplets.   You can choose

any color for the highlights.  Clicking the
left box pulls up the color picker you’ve
chosen in your graphics program.   Clicking
one of the next two boxes pulls up your
previously chosen foreground or back-
ground color.  Clicking the eyedropper tool
allows you to choose any color inside the
preview image by clicking on it.

Shadow Color
Controls the color of the shadow around
the droplets.   See Highlight Color.

The drip on the left uses a low Taper value; the one
on the right uses a high Taper value.

A high Lighting Strength and Lighting Coverage yields
drips with a very 3-D appearance.
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Fire

The Fire filter quickly creates a wide range
of fire and flame-like effects.   A color
gradient editor is included to allow users to
choose their own color scheme.

  This filter requires a selection if you
are using it on a background layer.

Controls

Direction
Controls the direction the flames move away
from the selection.   Use the circular slider
or enter a numeric value between 0 and 360
degrees.

Column Length
Controls the length of the entire flame
effect.   Higher values yield longer flames.

Flame Width
Controls the average width of the individual
flames.   Higher values yield wider flames.

Side Taper
Controls the amount the fire narrows as it
moves away from the selection.   Higher
values yield a stronger taper.

Movement
Adds random curling to the individual
flames.   Higher values add more curling.

Denser Flames
Checking this box will render additional
individual flames for a more full effect.

Residents picture courtesy of the Cryptic Corporation
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Start from Far Side
Checking this box starts the flames from
the selection edge opposite the flame
direction.

Draw Only Outside Selection
When checked, fire will appear only outside
the selection.   If Start From Far Side is
checked, Draw Only Outside Selection will
be unavailable and will be grayed out.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

  Feathering a selection before
applying Fire provides a softer effect.

Color Tab

Natural Spectrum
When checked, this box creates a realistic
orange, yellow and white fire.   When
unchecked, the color gradient editor below
is enabled.

Using the Color Gradient Editor
(See page 90 for color examples)

Setting Up A Gradient
Every color gradient begins with the left
color stop.  You can’t move this stop, but
you can add new color stops by simply
clicking along the bottom edge of the
color gradient region.

For each color stop you add, you’ll see a
white dot appear above the gradient region
at the midpoint between the new stop and
those next to it.  This determines how
quickly the color and opacity will blend
between color stops.   If you click and drag
the white dot closer to one color stop,
you’ll notice a more abrupt color/opacity
transition.

We have included presets that demonstrate
this element.  Choose the “Rainbow”
gradient from the list in the Gradient
Editor.  Notice how the dropoff from blue
to red is much more abrupt than that from
red to yellow.  Then notice how the white
dots above the gradient region control the
dropoff.  Feel free to experiment.

To remove a color stop from the color
gradient, click to highlight it and then
click the “Remove” button, or just drag the
color stop off the bottom of the color
gradient bar.   Removing color stops will
simplify a color gradient.

Choosing Colors
Change the color of any color stop by
clicking it once to highlight it, and then
using the “Color” control below to choose
the color picker (left box) or your fore-
ground or background color.  You can also
use the eyedropper tool to choose any
color from within your preview window.

Adjusting Opacity
You can adjust the opacity of any color
stop by clicking it once to highlight it,
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and then using the “Opacity” control to change
the transpaarency of that particular color stop.

  if the outer edge of your flame looks too
precisely defined, move the right-hand color stop
away from the very edge of the gradient region.
This allows for a less harsh dropoff.

Note: The Color and Opacity controls are designed
to give you precise control over your gradient,
and so work only on the highlighted color stop.
To adjust the color or opacity of a different color
stop, simply click it once to highlight it.

  If you ever feel the current color gradient
has gotten too complex, remember that hitting the
F5 key will reset the filter to a simple factory
default setting.  Also, don’t forget that you have
unlimited “Undo” capablities from the Edit Menu,
or by using the Control-Z keyboard shorcut.

Flame Width set to low (left) and medium (right).  A high
Flame Width produces fewer, wider flames.

Side Taper set high (left) and low (right).  Note how the
flames get narrower at the top when Side Taper is used.

Checking Start From Far Side (left) draws the flames starting
from the side opposite the Flame Direction.  At right, the same
effect with Start From Far Side turned off.
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Draw Only Outside Selection is turned on at left; it
doesn’t allow the flames to cover any of the selection.
Draw Only Outside Selection is turned off at right,
allowing the flames to cover part of the selection.
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Fur

The Fur filter creates a variety of fur and
hair effects: fuzzy textures, wavy curls, long
strands and more.

  For very thick fur, apply the filter
multiple times, varying the Direction and
Length slightly, and use a  different Random
Seed.

Controls

Direction
Controls the direction in which the hairs
grow.   Use the circular control or enter a
numeric value beteen 0 and 360 degrees.

Density
Controls the density of the hair strands.
Higher values create more hairs.

Curl Size
Controls the size of the curls in the hair.
Higher values yield larger curls.

Curliness
Controls the amount the hair curls.   Higher
values yield curlier hair.  Note: if Curliness is
very low, changes to Curl Size may not yield
a noticeable effect.

Length
Controls the length of the hairs.   Higher
values yield longer hairs.
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Draw Only Inside Selection
When this box is checked, fur will appear
inside the selection only.

Color Hairs Uniformly
When this box is checked, the hairs will be
created with only one color.   Checking this
box enables the Hair Color control.

Hair Color
Choose any color for the hair.   Clicking the
left box pulls up the color picker you’ve
chosen in your graphics program.   Clicking
one of the next two boxes pulls up your
previously chosen foreground or back-
ground color.  Clicking the eyedropper tool
allows you to choose any color inside the
preview image by clicking on it.

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Lighting Tab

Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;

higher values increase the intensity.

Highlight Color
Choose any color for the shiny highlights.
See Hair Color.

The left side of the animal hide was created using a
high Density, moderate Curl Size and short Length.
The right side uses the same settings, but with a high
Length.  Fur was applied twice on this side, with a
slightly different Direction and a new Random Seed
each time for a thicker Fur effect.

Above: Very low Curl Size and very high Curliness.

Above: the same settings, but with a high Curl Size.
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Glass

The Glass filter creates a layer of clear or
colored glass over your selection.  The glass
effect is achieved by simulating three
physical effects; refraction, light filtering
and light reflection.   These are controlled
by the Refraction, Color and Opacity, and
Highlight and Light Direction sliders,
respectively.

  This filter works best on large, simple
selections that are not filled in with a solid
color.  Try using Glass with the rectangle
and ellipse selection tools.

Controls

Bevel Width
Adjusts the width of the bevel at the edge of
your glass.   Note that any Refraction will
take place in the bevelled areas of the effect.

Smoothness
Controls how smooth or ridged the bevel
around the glass will appear.  Higher values
produce a more rounded bevel.

Bevel Placement
Clicking “Inside Selection” means the bevel
will appear inside the selection.  Click
“Outside Selection” if you want the bevel to
affect the area outside the edge of the
selection.
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Edge Darkening
Lightens or darkens the edge of the glass
effect.   The slider ranges from -100 to
+100; negative values lighten the glass
edge and positive values darken it.

Gradient Shading
Adds a shading gradient from dark to light
inside the glass, along the direction you
set for the Direction slider on the Lighting
tab (see below).

Refraction
Controls the amount your selection will be
warped by the glass over it.   Note that the
warping is most visible under bevelled
areas of the glass; if you are not seeing the
Refraction you like with a high value, try
increasing the Bevel Width.   Refraction
will only work on objects on the same
layer as the glass effect.

Opacity
Controls the amount light is prevented
from passing through the glass.   Low
values yield more transparent glass; high
values yield opaque glass that will block
underlying layers.

Tinting
Controls the amount the light is colored by
the Glass Color as it passes through the
glass.   Higher values tint the glass more
noticeably.

Glass Color
Choose any color for tinting the glass.
Clicking the left box pulls up the color
picker you’ve chosen in your graphics
program.   Clicking one of the next two
boxes pulls up your previously chosen
foreground or background color.  Clicking
the eyedropper tool allows you to choose
any color inside the preview image by
clicking on it.

Lighting Tab

Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Inclination
Controls the angle formed between the
light and the page.  Click and drag within
the lighting control box to change the
inclination, or enter a numerical value
between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;
higher values increase the intensity.

Highlight Size
Controls the size of the shiny highlights
appearing on areas facing the light; higher
values yield larger highlights.

Highlight Color
Choose any color for the shiny highlights
added to the bevel around the glass effect.
See Glass Color for more.

Ripple Thickness
Controls the thickness of lumpy imperfec-
tions in the Glass effect.   Higher values
produce a stronger, more rippled effect.

Ripple Width
Controls the width of lumpy imperfections
in the surface.   Higher values yield wider
ripples.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.
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Bevel Profile Tab

This tab gives you direct control over the shape of
the bevel, as seen from a side profile.   It includes
a list of saved profiles, a profile editing window
and a“Sharp corner” box, as seen on the next page.

Using the list of saved bevel profiles
The bevel profile editor comes with a set of saved
profiles for you to experiment with.   We recom-
mend that you examine the profiles included in
the list to see how they affect a preview image.

You can create and save your own bevel profiles.
To add a profile to the list, just click the “Add”
button.   You will be asked to name the current
bevel profile.   Click “OK” and the new profile will
now appear whenever you open the bevel profile
editor in this filter.

To rename a profile, click the “Rename” button.

To delete a profile from the list, click the “Delete”
button.

  The “Undo” feature will not work after
adding, renaming or deleting bevel profiles.   Once
you delete a bevel profile, it’s gone for good, so be

sure you want to delete it before actually doing
so.

Shaping the bevel profile
Below the list of profile names is the current bevel
profile.   Shape the bevel by clicking anywhere
along the profile to add a new control point and
then drag it to create the desired shape.   The
editor will draw the simplest curve that fits the
points you’ve added.

To remove a control point from the bevel profile,
click to highlight it and then click the “Remove”
button, or just drag the control point out of the
bevel profile box.   Removing control points will
simplify a bevel profile.

Sharp Corner
Clicking this box changes the profile shape at the
highlighted control point.   Each control point can
create either a smooth curve or a sharp corner.

  If you ever feel the current bevel profile has
gotten too complex, remember that hitting the F5
key will reset the filter to a simple factory default
setting.  Also, don’t forget that you have unlimited
“Undo” capablities from the Edit Menu, or by using
the Control-Z keyboard shorcut.

For detailed examples of different bevel profiles
and their effect on an image, see pages 24-25 in
the Bevel Boss filter chapter.
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The glassware above was created using the “Multiple
Bevels” profile found on the Bevel Profile tab in Glass.
Bevel Width 0.58, Edge Darkening 3, Refraction 87,
Opacity 0, Tinting 24 and a very light aqua Tint
Color.   The filter was applied to an empty circular
selection.

Refraction takes place under beveled areas of the
Glass.   If you aren’t seeing the distortion you’d like,
try increasing the Bevel Width, or experimenting with

another Bevel Profile.   This effect was created with
the “Cutaround” profile and a Bevel Width of 0.23,
with a slight red Tint.

Solid glassy effects can be obtained with a high
Opacity and Tint Color.

Using high values for Edge Darkening and Gradient
Shading can help the Glass effect stand out more
clearly.   Notice the Gradient goes from dark to light
as it moves from the upper left  of the oval to the
lower right.   Gradient Shading will follow whatever
direction you have set for the Light Direction slider on
the “Lighting” tab.
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Gradient Glow

The Gradient Glow filter can create a
variety of realistic glows around the
outside edge of a selection, including
complex color gradients.

  This filter requires a selection if you
are using it on a background layer.

Controls

Glow Width
Controls how far the glow extends out
from the edge of your selection; high
values yield a wider Glow.

Soft Corners
Clicking this box creates a very diffuse
glow with softer edges around angular
selections.

Overall Opacity
Controls the opacity of the overall Glow
effect.  Low values yield a more transpar-
ent Glow; high values yield a more solid,
opaque Glow.

Draw Only Outside Selection
When this box is checked, the glow will
only appear outside the selection.   If this
box is unchecked, the glow will be
allowed to fill the entire selection.
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Using the Color Gradient Editor
(See page 89 for color examples)

Setting Up A Gradient
Every color gradient begins with the left
color stop.  You can’t move this stop, but
you can add new color stops by simply
clicking along the bottom edge of the
color gradient region.

For each color stop you add, you’ll see a
white dot appear above the gradient
region at the midpoint between the new
stop and those next to it.  This determines
how quickly the color and opacity will
blend between color stops.   If you click
and drag the white dot closer to one color
stop, you’ll notice a more abrupt color/
opacity transition.

We have included presets that demonstrate
this element.  Choose the “Rainbow”
gradient from the list in the Gradient
Editor.  Notice how the dropoff from blue
to red is much more abrupt than that from
red to yellow.  Then notice how the white
dots above the gradient region control the
dropoff.  Feel free to experiment.

To remove a color stop from the color
gradient, click to highlight it and then
click the “Remove” button, or just drag
the color stop off the bottom of the color
gradient bar.   Removing color stops will
simplify a color gradient.

Choosing Colors
Change the color of any color stop by
clicking it once to highlight it, and then
using the “Color” control below to choose
the color picker (left box) or your
foreground or background color.  You can
also use the eyedropper tool to choose
any color from within your preview
window.

Adjusting Opacity
You can adjust the opacity of any color
stop by clicking it once to highlight it,
and then using the “Opacity” control to
change the transpaarency of that particu-
lar color stop.

  If you ever feel the current color
gradient has gotten too complex, remem-
ber that hitting the F5 key will reset the
filter to a simple factory default setting.
Also, don’t forget that you have unlimited
“Undo” capablities from the Edit Menu, or
by using the Control-Z keyboard shorcut.

The Soft Corners slider at a low setting (left) and a
medium setting (right).
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HSB Noise

The HSB Noise filter allows you to add visual
noise to a selection by varying Hue, Satura-
tion, Brightness and other values.  Noise is
usseful for adding texture to a selection,
which can help it appear both more interest-
ing and more natural.

  This filter only works in RGB mode.

  For color examples of the HSB Noise
filter at work, see page 92.

Controls

Hue Variation
Controls the range of variation in hue.
Higher values yield a more colorful appear-
ance.

Saturation Variation
Controls the range of variation in saturation.
Higher values yield a wider range in satura-
tion of the colors in the noise.

Brightness Variation
Controls the range of variation in bright-
ness.   Higher values yield a wider range in
brightness of the colors in the noise.

Opacity Variation
Controls the range of variation in transpar-
ency of the noise.   Higher values yield a
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wider range of opaque and transparent
noise lumps.   Note: variations in opacity
will not be apparent if you are working on
a background layer, as there is no layer
underneath the background.   Transparent
noise applied to a selection in a layer
creates random, semi-transparent spots.

Lump Width
Controls the horizontal size of the bits of
noise.   Higher values yield wider noise
lumps.

Lump Height
Controls the vertical size of the bits of
noise.   Higher values yield longer noise
lumps.

Pattern
Choose one of three patterns for the noise:

Smooth Lumps - creates smooth, lumpy
noise

Smooth Fractal - creates a more natural
noise with fractal detail at many levels

Wrinkled Fractal - creates fractal detail with
sharp creases and visible lines around noise
regions

Fractal Roughness
Choosing the Smooth Fractal or Wrinkled
Fractal patterns will enable this slider,
which controls the amount of detail in the
fractal patterns.   Higher values yield a
rougher, more detailed appearance, useful
for natural textures.

Experiment with these three patterns to
find the one right for the job!

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

     

Using a Lump Width greater than Lump Height (left)
creates a horizontal noise effect.   Using a Lump
Height greater than Lump Width (right) yields a
vertical effect.  The larger the difference between the
two settings, the more pronounced the directional
effect.   Setting Width and Height to the same value
eliminates the directional element (center).

Left: using the Wrinkled Fractal option with a low
Fractal Roughness setting of 7.   Right: Wrinkled
Fractal with Fractal Roughness setting of 87.
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Jiggle

The Jiggle filter produces a powerful
distortion based on randomly-spaced
bubbling.  Unlike the Photoshop distorion
filters, Jiggle is not based on a wave
pattern, or around a single axis.  Instead,
Jiggle yields a more organic distortion,
resulting in a selection that appears as if it
is bubbling, gelatinous or even shattered.

Controls

Movement Type
Choose from three types of warping:
Bubbles, Brownian Motion or Turbulence.
Bubbles creates smoother distortions, while
Brownian Motion and Turbulence yield much
busier and sharper results.

Bubble Size
Controls the spacing or frequency of the
warp defects.   Higher values yield larger
and fewer warps.

Warp Amount
Controls the amount of distortion of each
warp defect.   Higher values increase the
distortion.

Twist
Controls the amount of twisting added to
the distortion.   Higher values yield a more
twisted effect.
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Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

On the left, low Bubble Size (.16 inches) yields a very
distorted effect.   On the right, high Bubble Size (1.29
inches) yields a gentler distortion.   All other settings
remained the same: Warp 0.27, Twist 30, using the
“Bubbles” movement type.

Using the Turbulence Movement Type creates a much
busier distortion.  Left: medium Bubble Size and high
Twist.   Right: High Warp values using Turbulence
create a smashed effect.

Left: high Bubble Size and Warp Amount with Twist set
to 0.  Right: the same, but with Twist set to 90.  Note
also that extremely high Warp Amounts will distort so
much that pieces will appear to have broken away
from the main image.
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Marble

The Marble filter creates a variety of realistic
marble textures, including full control over
the color, size and shape of the rock and
vein features.  The seamless tiling option
allows you to easily create smoothly pat-
terned marble backgrounds.

Controls

Vein Size
Controls the size of the vein elements;
higher values yield larger features.

Vein Coverage
Controls the length of the marble veins.

Vein Thickness
Controls the thickness of the marble veins;
higher values yield thicker veins

Vein Roughness
Controls the sharpness of the detail in the
marble veins; lower values yield more blurry
veins

Bedrock Color
You can choose any color for the rock.
Clicking the left box pulls up the color
picker you’ve chosen in your graphics
program.   Clicking one of the next two
boxes pulls up your previously chosen
foreground or background color.  Clicking
the eyedropper tool allows you to choose
any color inside the preview image by
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clicking on it.

Vein Color
You can choose any color for the veins
running through the rock.   See Bedrock
Color.

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Clockwise from the top left, increasing the Feature Size
while keeping other sliders constant.

Clockwise from the top left, increasing the Vein Detail
while keeping other sliders constant.

Vein Roughness values of 8 (on left) and 80 (right),
with other sliders held constant.
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Melt

The Melt filter turns up the heat on any
image, creating the appearance of melting,
including the pooling of the selection at the
bottom of the melted area.

  Melt is an excellent complement to
the Drip filter.   Try running Melt first on a
selection, then follow up with Drip for a
highly realistic effect.

Controls

Ripple Width
Controls the size of the wave variations that
create the melt effect.   Higher values yield
larger rippled distortions.

Stretch Length
Controls the maximum amount the selection
will be stretched vertically.   Higher values
yield a more elongated melting.

Pooling
Controls the amount the selection will
collect at the bottom of the melted area.
Higher values create a stronger appearance
of downward flow.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.
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Above: a low Ripple Width value of 0.15 creates a
busy Melt effect with relatively small wavy variations.

Here, a higher Ripple Width of 0.32 yields larger
variations, producing bigger melted blobs.

Increasing the Pooling value causes the selection to
form a puddle at the bottom of the effect.   Top:
Pooling set at 20.  Middle: Pooling at 50.  Bottom:
Pooling at 80.  All other controls were kept constant.
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Motion Trail

The Motion Trail filter draws a trail from the
selection to create the appearance of rapid
movement.

  This filter requires a selection if you
are using it on a background layer.

Controls

Direction
Controls the direction the motion trail
moves away from the selection.   Use  the
circular slider or enter a numeric value
between 0 and 360 degrees.

Length
Controls the length of the trail moving away
from the selection.

Taper
Controls the amount the trail shrinks as it
moves away from the selection.   Higher
values yield a narrower, more tapered trail.

Overall Opacity
Controls the opacity of the motion trail.
Lower values yield a more transparent effect.

Smear Color from Edges
Checking this box smears the colors only
from the edges of the selection.   This leaves
the selection relatively distinct.
Unchecking this box will result in the
motion trail obscuring the image more fully.
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causes the Draw Only Outside Selection
control to be grayed out and unavailable.

Draw Only Outside Selection
When this box is checked, the motion trail
will appear only outside the selection.
This is useful for making sure the selection
is visible when using a high Overall Opacity
and a Direction that obscures part of the
selection.   When this box is unchecked,
the motion trail will be allowed to cover
part or all of the selection.

Left: Motion Trail applied to the earth with a medium
Taper.  Right: Motion Trail applied to the baseball
with a high Taper.

Left: Smear Color From Edges on.  Right: Smear Color
From Edges off.

Here, Smear Color From Edges is off and Draw Only
Outside Selection on, yielding a fuller Motion Trail
effect with the selection clearly visible.
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Shadowlab

The Shadowlab filter easily creates drop and
perspective shadows that add a 3-D quality
to any document.  This filter is particularly
useful for making an object spring to the
foreground of a composition.

  This filter requires a selection if you
are using it on a background layer.

Controls

Center Offset Direction
Controls the direction the shadow is moved
from the center of the selection or layer.
Use  the circular slider or enter a numeric
value between 0 and 360 degrees.

Center Offset Distance
Controls the distance of the shadow from the
center of the selection or layer.

Overall Opacity
Controls the opacity of the entire shadow.
A low value yields a more transparent
shadow.

Overall Blur
Applies a uniform Gaussian Blur over the
entire shadow.   High values yield a blurrier
effect, implying a light source that is softer
or farther away.
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Perpsective Blur
Applies a blur that increases as it moves
away from the shadow base.   High values
produce a blurrier effect.

Color
You can choose any color for the shadow.
Clicking the left box pulls up the color
picker you’ve chosen in your graphics
program.   Cicking one of the next two
boxes pulls up your previously chosen
foreground or background color.  Clicking
the eyedropper tool allows you to choose
any color inside the preview image by
clicking on it.

Draw Only Outside Selection
Checking this box will draw the shadow
outside of the selection only.   Unchecking
this box will create a shadow that fills the
entire selection, useful if you want to
create a full shadow on its own layer.

  Using an empty selection on a layer,
uncheck the Draw Only Outside Selection
box.   This will create a full shadow which
you can easily manipulate.   Move the
shadow layer below the original image
layer and place the shadow as desired.

Photoshop users: we have included an
Action on the Eye Candy 4000 CD that will
automatically create a full shadow on a
new layer.

In-Preview Controls

Shadowlab is one of two filters which
contains In-Preview Controls (the other is
Star).

Clicking the arrow next to the magnifying
glass creates “control points” on the
shadow which allow you to directly
manipulate it from within the preview
window.  These control points alter the
shape and position of the shadow, shrink-
ing, enlarging, distorting and moving it for
a wide range of perspective and drop
shadow effects.  You can also use the
numerical controls in the Center Offset
Direction and Center Offset Distance sliders,
if you prefer them for adjusting the
position of the shadow, but distortions can
only be done with the In-Preview Controls.

Notice in the following diagram that
clicking the In-Preview Control arrow gives
you six control points in a rectangle
surrounding the shadow:

Clicking and dragging any of the points
stretches the shadow in that direction:
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Clicking and dragging anywhere inside the control
rectangle moves the shadow in the desired direc-
tion.

  If you find, after playing with the control
points, that you prefer to use a simple drop
shadow, clicking the F5 key will reset Shadowlab
to its default setting: a simple drop shadow.   You
can also click “Reset to factory default” from the
Settings menu.

Low Center Offset Distance (top) and high Center Offset
Distance (bottom).   Notice how the 3-D effect changes.

Creating a Perspective Shadow

1 - Click the arrow tool above the preview window
to enable the In-Preview Control Points.

2 -  Use the bottom middle control point to join
the bottom of the shadow to the bottom of your
selection.

3 -  Now use the top control points to angle the
perspective shadow in the direction you prefer.

4 - Adjust the Perspective Blur slider to the
desired setting.

You’ve just created a realistic perspective shadow.
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Above: low Overall Blur combined with very low
Perspective Blur.

Same Overall Blur, but with a high Perspective Blur.

You can use control points to move the shadow in
front of the object as well as behind it.

A quick bevel and a subtle drop shadow are perfect for
creating text that stands out from a Web page or
printed document.
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Smoke
The Smoke filter creates billowing smoke,
haze, fog, fumes and more.  A color gradient
editor is included to provide a wide variety
of color choices for the effect.

  This filter requires a selection if you
are using it on a background layer.

Controls

Direction
Controls the direction the smoke moves
away from the selection.   Use the circular
slider or enter a numeric value between 0
and 360 degrees.

Column Length
Controls the length of the entire smoke
effect.   Higher values yield longer smoke.

Side Taper
Controls the amount the smoke narrows as it
moves away from the selection.   Higher
values yield more narrowing.

Eddy Size
Controls the average size of the turbulent
curves in the smoke flow.   Higher values
yield larger turbulent swirls.

Turbulence Strength
Controls the amount the smoke meanders
away from a straight path.   Higher values
yield more turbulent and dispersed smoke.
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Turbulence Roughness
Controls the amount of detail in each
turbulence eddy.   Higher values yield
rougher, more detailed smoke.

Blur
Controls the amount to blur the smoke
effect.   This is useful for removing any
speckling that may appear as the smoke is
drawn.

Start From Far Side
When checked, this box draws the smoke
starting from the selection edge opposite
the smoke direction.   This produces smoke
that covers the front of the selection.

Draw Only Outside Selection
When this box is checked, smoke will only
appear outside the selection.   If this box
is unchecked, wisps of smoke will be
allowed to cover part or all of the selec-
tion.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Color Tab

Natural Spectrum
When checked, this box creates a realistic
gray and white smoke.   When unchecked,
the color gradient editor below is enabled.

Using the Color Gradient Editor
(See page 90 for color examples)

Setting Up A Gradient
Every color gradient begins with the left
color stop.  You can’t move this stop, but
you can add new color stops by simply
clicking along the bottom edge of the
color gradient region.

For each color stop you add, you’ll see a
white dot appear above the gradient region
at the midpoint between the new stop and
those next to it.  This determines how
quickly the color and opacity will blend
between color stops.   If you click and drag
the white dot closer to one color stop,
you’ll notice a more abrupt color/opacity
transition.

We have included presets that demonstrate
this element.  Choose the “Rainbow”
gradient from the list in the Gradient
Editor.  Notice how the dropoff from blue
to red is much more abrupt than that from
red to yellow.  Then notice how the white
dots above the gradient region control the
dropoff.  Feel free to experiment.

To remove a color stop from the color
gradient, click to highlight it and then
click the “Remove” button, or just drag the
color stop off the bottom of the color
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gradient bar.   Removing color stops will simplify a
color gradient.

Choosing Colors
Change the color of any color stop by clicking it
once to highlight it, and then using the “Color”
control below to choose the color picker (left box)
or your foreground or background color.  You can
also use the eyedropper tool to choose any color
from within your preview window.

Adjusting Opacity
You can adjust the opacity of any color stop by
clicking it once to highlight it, and then using the
“Opacity” control to change the transpaarency of
that particular color stop.

  If the right-hand color stop is at the very
end of the gradient, the smoke may have a harsh
outer edge.   Move the color stop slightly to the
left to soften the edge.

   If you ever feel the current color gradient
has gotten too complex, remember that hitting the
F5 key will reset the filter to a simple factory
default setting.  Also, don’t forget that you have
unlimited “Undo” capablities from the Edit Menu,
or by using the Control-Z keyboard shorcut.

A high Side Taper (left) and a low Side Taper (right).

A low Eddy Size (left) and a high Eddy Size (right).
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Smoke with high Turbulence Roughness and moderate
Turbulence Strength.

The checkboxes in Smoke.  Top: Start From Far Side
checked.  Middle: No checkbox checked.  Bottom: Draw
Only Outside Selection checked.
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Squint

The Squint filter creates realistic organic
blurring by spreading each pixel in your
selection around the edge of a circle.   The
result is a blur that closely duplicates the
effect of poor vision, an image projected out
of focus or a reflection in a vibrating mirror.

Controls

Radius
This slider controls the radius of the circles
around which your selection is blurred; i.e.,
this slider changes the vibration of the
mirror or the focus on the projector.   The
larger the radius, the blurrier the image will
be.   As the radius value increases, the
specifics of your selection are spread over a
greater distance, and the selection becomes
more fuzzy.

Fuzzy Dice.  Top: the original image; middle, Squint
applied with Radius set at 7; bottom, Radius at 12.
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Squint can be used to bring attention to a part of a
photo by defocusing the surrounding area.  In the
photo above, we’ve selected the area around the boy
in the blue inner tube.

After applying Squint to the area around the boy,
only the boy remains in focus while the background is
blurry.

Squint applied to an opaque star in a layer without a
selection.  On the right, notice how the background is
visible through the blurred edges of the star.  Squint
affects transparency when it is applied to an object in
its own layer.

Squint can also be used to protect the innocent until
proven guilty in a court of law.  A circular selection is
made over the naughty CEO’s face.  The selection is
feathered slighty and Squint is applied, making his
lawyers very happy.
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Star

The Star filter quickly creates stars and
other regular polygon shapes without the
need to import them from another program
or use paths to approximate them.

  If you use the Star filter on a selec-
tion, your polygon will initially be placed
in the center of that selection.   If the star is
bigger than your selection, only part of the
star will show.   Use the Radius and Distance
controls to easily shift the size and position
of the star.

If you use Star in a completely empty layer,
the effect will initially appear  in the center
of your image.

 See page 89 for color examples of Star.

Controls

Number of Sides
Use the slider or enter a numberic value to
choose from 3 to 50 sides for your polygon.

Indentation
Controls the amount of indentation of the
polygon’s sides into the center.   Use a value
of zero to create regular shapes like penta-
gons and octogons.

Overall Opacity
Controls the opacity of the star effect.   A
low value yields a more transparent star.
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Radius
Controls the size of the polygon.

Orientation
Controls the angle of rotation of the star.
Use the circular slider or enter a numeric
value between 0 and 360 degrees.

Center Offset Direction
Controls the direction the polygon is
moved from the center of the selection or
layer.   Use  the circular slider or enter a
numeric value between 0 and 360 degrees.

Center Offset Distance
Controls the distance of the star from the
center of the selection or layer.   A value of
0 leaves the star in the center.

In-Preview Controls

Star is one of two filters which contains In-
Preview Controls (the other is Shadowlab).

Clicking the arrow next to the magnifying
glass creates two “control points” on the
star which allow you to directly manipu-
late it from within the preview window.
These control points alter the radius,
orientation and position of the star.  You
can also use the numerical controls in the
Center Offset Direction, Center Offset
Distance, Radius and Orientation sliders, if
you prefer them to the In-Preview controls
in Star.

Notice in the following diagram that
clicking the In-Preview Control arrow gives
you two control points along a line:

Clicking and dragging the outer point
controls the radius and angle of orienta-
tion.  In the following picture, we have
dragged the outer control point to increase
the size of the star and rotate it a few
degrees.

In this case, the result is a larger star with
a new orientation (next column):

Clicking and dragging on the central
control point, or anywhere else along the
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control point line, moves the control bar in the
preview window:

The star’s placement will shift to match the new
position without adjusting the radius or orienta-
tion.

Color Tab

Using the Color Gradient Editor
(See page 89 for color examples)

Setting Up A Gradient
Every color gradient begins with the left color

stop.  You can’t move this stop, but you can add
new color stops by simply clicking along the
bottom edge of the color gradient region.

For each color stop you add, you’ll see a white dot
appear above the gradient region at the midpoint
between the new stop and those next to it.  This
determines how quickly the color and opacity will
blend between color stops.   If you click and drag
the white dot closer to one color stop, you’ll
notice a more abrupt color/opacity transition.

We have included presets that demonstrate this
element.  Choose the “Rainbow” gradient from the
list in the Gradient Editor.  Notice how the dropoff
from blue to red is much more abrupt than that
from red to yellow.  Then notice how the white
dots above the gradient region control the
dropoff.  Feel free to experiment.

To remove a color stop from the color gradient,
click to highlight it and then click the “Remove”
button, or just drag the color stop off the bottom
of the color gradient bar.   Removing color stops
will simplify a color gradient.

Choosing Colors
Change the color of any color stop by clicking it
once to highlight it, and then using the “Color”
control below to choose the color picker (left box)
or your foreground or background color.  You can
also use the eyedropper tool to choose any color
from within your preview window.

Adjusting Opacity
You can adjust the opacity of any color stop by
clicking it once to highlight it, and then using the
“Opacity” control to change the transpaarency of
that particular color stop.

  You may see a visible aliased outer edge on
the star effect if the right-hand color stop is at the
extreme right end of the gradient region.   Move
the color stop slightly to the left to soften this
edge.
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gradient has gotten too complex, remem-
ber that hitting the F5 key will reset the
filter to a simple factory default setting.
Also, don’t forget that you have unlimited
“Undo” capablities from the Edit Menu, or
by using the Control-Z keyboard shorcut.

  To create a star made up of one solid
color, place two matching color stops at
either end of the gradient editor.  Check
the color gradient used in the setting
called “Solid Star” for an example.

From left to right, a star with Indentations of 0, 40
and 80.   The Number of Sides was kept constant at
8.
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Swirl

The Swirl filter smears your selection using
randomly-placed whirlpools.  The spacing
and shape of these whirlpools can be
controlled to achieve an amazing variety of
texture effects, from spirals to crystalline
effects and more.

  Swirl tends to have a striking effect
on images containing lots of detail and
speckles.  Try using HSB Noise on your
selection first, and then applying Swirl.

Controls

Whirlpool Spacing
Although the whirlpools are randomly
placed, this slider gives you control over the
average spacing between their centers.
Lower values yield many closely-spaced,
tiny whirlpools.   Large values can create
long streamlines with no visible whirlpool
center.

Smear Length
Controls the amout of blurring of the swirl
effect; higher values blur the image more.
Try experimenting with lower values first, as
a high Smear Length can take a long time to
render.

  If you are using Swirl on a large
selection and finding render times long,
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consider using Swirl on a small selection
and then checking the Seamless Tile box
(see below).   See the special section on
page 14 for information about easily
creating seamless tiles.

Twist
Controls the amount of twisting of the flow
lines as they move out of the whirlpool
center.   A value of 0 creates relatively
straight flowlines, which can produce
interesting flowery or starbust effects.   A
value of 100 creates circular flowlines.
Values between 0 and 100 produce spiral
effects.

Streak Detail
Strengthens the flow lines of the whirlpools
so that they become more visible.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Increasing the Whirlpool Spacing (left to right) yields
larger whirlpools.  We’ve also increased the Smear
Length, which blurs the image for an increasingly
softer effect.

On the left, a low Twist value yields straight flowlines;
at right, a high Twist produces a circular effect.
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Water
Drops

The Water Drops  filter creates a variety of
realistic liquid shapes and textures in any
color, including drops, spills, spurts and
more.

Controls

Drop Size
Controls the size of the liquid blobs; lower
values yield a more splattered effect, while
higher values yield fewer, larger areas of
liquid.

Coverage
Controls the percentage of the selection that
is covered in liquid, from 10% to 100%.

Edge Darkening
Controls how much the edges of the liquid
will be ightened or darkened.   The slider
ranges from -100 to zero to +100; negative
values lighten the drop edges, while positive
values darken the drop edges.

Opacity
Controls the amount that light is prevented
from passing through the liquid; higher
values yield a more opaque liquid.

Refraction
Controls the amount that light is distorted
as it passes through the liquid.   Higher
values will more heavily distort the selec-
tion.
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Liquid Color
You can choose any color for the liquid.
Clicking the left box pulls up the color
picker you’ve chosen in your graphics
program.   Clicking one of the next two
boxes pulls up your previously chosen
foreground or background color.  Clicking
the eyedropper tool allows you to choose
any color inside the preview image by
clicking on it.

Round Drops
Checking this box renders the liquid effect
as perfectly round drops.

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Lighting Direction
Controls the direction from which the light
falls on your selection.   Click and drag
within the lighting control box to change
the direction, or enter a numerical value
between 0 and 360 degrees.

Lighting Inclination
Controls the angle formed between the
light and the page.  Click and drag within
the lighting control box to change the
inclination, or enter a numerical value
between 0 and 90 degrees.

Highlight Brightness
Controls the intensity of the shiny high-
lights appearing on areas facing the light;
higher values increase the intensity.

Highlight Sharpness
Controls the size of the shiny highlights
appearing on areas facing the light; higher
values yield larger highlights.

Highlight Color
Controls the color of any shiny highlights
added to your droplets.   See Liquid Color.

Left to right: Low, medium and high Drop Size.

The same settings used with the Round Drops
checkbox unchecked (top) and checked (bottom).
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Weave

The Weave filter recreates your selection to
give it the appearance of being woven.   You
have control over the width of the strips and
gaps that form the weave, as well as control
over what is seen through any weave gaps.
You can also add texture to the woven
threads.

Controls

Ribbon Width
Controls the width of the shaded strips;
higher values yield wider ribbons.

Gap Width
Controls the width of the holes between the
ribbons, higher values yield wider gaps

Shadow Strength
Controls the darkness of the shadows on the
ribbons.   With a lighter selection, darken-
ing these shadows will make the strips
appear thicker.   When using Weave on a
dark selection, high Shadow Strength values
may be necessary for the shadows to be
noticeable.

Thread Detail
Adds a cloth-like texture to the woven
ribbons by adding bright and dark streaks
along the ribbons.   The more Thread Detail,
the more textured the ribbons will appear.



77Thread Length
Adds a cloth-like texture to the woven
ribbons by increasing the length of the
bright and dark Thread Detail streaks.

Smear Ribbons
When checked, this box smears the selec-
tion along the threads.   If you have set a
high Thread Length, you will see more
smearing.

Gap Fill
You have a choice as to what is visible
through any gaps in the Weave effect.

Fill with solid color - clicking here enables
the color picker, which allows you to
choose any color for the Gap Fill.

Keep original image - clicking here leaves
the original selection visible through any
gaps

Make gaps transparent - clicking here
leaves any gaps transparent, leaving
underlying layers visible through the Weave
effect.

  If you are working on a background
layer, the “Make gaps transparent” option
will be grayed out and unavailable.

Left: “Fill with solid color” is checked and a gray color
selected.  Right: “Make gaps transparent” is checked,
allowing an underlying layer to be visible.

Clockwise from top left: low Ribbon Width and low
GapWidth, high Ribbon Width and low Gap Width,
high Ribbon Width and high Gap Width, low Ribbon
Width and high Gap Width.
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Wood

The Wood filter quickly and easily creates a
variety of realistic wood effects, including
control over the grain, knots and rings in
the wood.

Controls

Direction
Controls the direction of the wood grain.
Use the circular slider or enter a numeric
value betwen 0 and 360 degrees.

Ring Thickness
Controls the distance between the growth
rings in the wood.   Higher values yield
thicker rings.

Cut Offset
Controls the amount the cut of the wood is
angled in relation to the log.   A value of 0
yields wood that has been cut along the
length of the trunk or limb.  Higher values
yield wood that has been cut at an angle to
the length of the trunk or limb.

Variation Amount
Controls the amount the rings deviate from
simple geometric curves.   Higher values
yield more varied rings.

Variation Roughness
Controls the amount of detail in the ring
variation.   Higher values yield more
distorted rings.
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Pulp Color
You can choose any color for the thick
rings that make up the wood pulp.  Click-
ing the left box pulls up the color picker
you’ve chosen in your graphics program.
Clicking one of the next two boxes pulls up
your previously chosen foreground or
background color.  Clicking the eyedropper
tool allows you to choose any color inside
the preview image by clicking on it.

Ring Color
You can choose any color for the thin rings
running through the pulp.  See Pulp Color.

Seamless Tile
Check this box to create a repeating
pattern with no seams.

  See the special section on page 14
for instructions on how to make seamless
tiles for your Web site, as computer
wallpaper or for importing as a texture
into a 3-D application.

Random Seed
Controls the random aspect of this filter so
you can easily duplicate effects that use
random elements.

Number of Knots
Controls the number of dark knots.
Choose from one to three knots.

Knot Size
Controls the approximate width of the dark
knots.   Higher values yield larger knots.

Grain Length
Controls the average length of the small
streaks that make up the grain.   Higher
values yield longer streaks.

Grain Width
Controls the average width of the small

streaks that make up the grain.   Higher
values yield wider streaks.

Grain Density
Controls the number of small streaks that
make up the grain.   Higher values yield
more streaks.

Grain Opacity
Controls the contrast of the grain streaks
against the rest of the wood; higher values
yield more opaque streaks.

Grain Color
You can choose any color for the grain
streaks.   See Pulp Color.

These knots in the wood were created using a low
Knot Ring Thickness and medium Knot Size.  Then click
the Random Seed button until you get knots that you
like.
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Trouble-shooting Eye Candy 4000

We have tried to collect the most commonly-asked
questions here.   A more up-to-date troubleshoot-
ing guide can be found in the Support section at
our Web site: http://www.alienskin.com.   If you
get really stuck, the best way to get help is to
send email to support@alienskin.com.  Include in
the email your 12 letter registration code, whether
you are using Mac or Windows and the graphics
host program (Photoshop, Paint Shop Pro, etc.)
you are using.

Looking for an old Eye Candy 3 filter?

Every one of the old Eye Candy 3 filters is present
in Eye Candy 4000; in some cases, it made sense to
combine effects into a newer, more powerful filter.
Please see the “Where Are My Old Filters?” section
on page 9 for more information.

Installation Issues

Problem:  Will Eye Candy 4000 overwrite my
previous version of Eye Candy?

Solution:  Eye Candy 4000 will not interfere with
Eye Candy 3 in any way.  Eye Candy 4000 and its
settings are installed in a new location that will
not overwrite Eye Candy 3’s files.

Problem:  The installer program is asking for a
Product Registration Code and I can’t find such a
code.

Solution:  The Product Registration Code is a 12-
letter code located either in your manual, on the
CD jewel case or, if you received an electronic

version of the software, in an email invoice
or electronic user license text file.  If you’ve
registered the software with us (by purchas-
ing directly from us, registering online or
sending in a registration card), we’ll have
the code in our database.  If you didn’t
register with us, contact us regarding how
to provide proof of purchase in order to get
registered and receive a new code.

Problem:  After installing the plug-ins and
starting the graphics host program, the
filters do not appear in the Filter or plug-in
menu.

Solution:  The filters were probably not
installed in your graphics program’s plug-in
folder.   Find out exactly which folder your
host program is using for plug-ins.   With
Photoshop, you can determine this by going
to File->Preferences->Plug-ins.   Then try
to install the filters again and make sure
you select the proper plug-in folder.   Also,
remember that after installing new filters,
you must restart your graphics program for
them to become available.   With other
graphic host programs, consult that
program’s manual for more information
about where the plug-ins need to be
installed and how to access them.

Problem:   Eye Candy 4000 doesn’t work
with a graphics program that says that it
uses Photoshop plug-ins.

Solution:  A program that claims it works
with Photoshop plug-ins doesn’t always
work with all Photoshop plug-ins.   Not
every software company strictly follows the
Photoshop plug-in standard.   If you have a
question about using Eye Candy 4000 with
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other software, please visit our Web site for
the latest compatibility information.

Problem: How do I uninstall Eye Candy
4000?

Mac Solution: Find the Eye Candy 4000
folder in your graphics program’s plug-in
folder and delete it.   Next go to your
System: Preferences folder, and find and
delete the file “Eye Candy 4000 Prefs”.

Windows Solution: Run Add/Remove
Programs from your Windows Control
Panel.   Select “Eye Candy 4000” from the
program list and click the “Add/Remove”
button.   This will remove the program and
most of its components.  Next go to your
plug-ins folder and delete the “Eye Candy
4000 Settings” folder.

Performance Issues

Problem:  All or some of the filters appear
grayed out in the Filter menu.

Solution:  This will occur if you are using
Photoshop 5.0 and are trying to apply
filters to type before you have rendered
the type layer.   Before using a filter on
type, make sure you have rendered the
type layer by choosing
Layer>Type>Render Layer from the menu
bar.

Grayed-out filters in the Filter menu also
occur if you are in certain color modes
that won’t allow a specific filter to work
properly.

Problem:  One of the filters seems to have
no effect on the image.

Solution:  This problem is usually due to
the use of extreme parameter settings.   Try
lowering any very large settings in the
Preview window.   Also make sure that the
Preserve Transparency checkbox is not
checked for the layer that you are working
with.   Another possibility is that you have
made your selection in a mostly transpar-
ent part of a layer and you are using a
filter that does not affect transparency.
Finally, you may have a layer selected that
is hidden behind other layers.

Problem:  I get a message that “Eye Candy
ran out of available memory while render-
ing the preview image does not have
enough memory to render the preview” or
a “Could not complete the <Filter Name>
command because there is not enough
memory (RAM)” when I run a filter.

Solution: Eye Candy 4000 works within the
memory allocated to Photoshop.  If
Photoshop’s memory is being taken up by
the image, the history palette, etc.,  there
may not be enough memory for Eye Candy
to draw its preview or render the effect.
The solution is to exit our filter, save your
image and do the following steps…

For Windows: With Photoshop 5.0 or later,
a lot of memory can be taken up with the
history palette and other features.  You can
free up this memory by selecting
Edit>Purge>All from the Photoshop menu.

For Mac: You can increase the memory
allocation by exiting Photoshop and
performing a Get Info on the Photoshop
program icon.   With Photoshop 5.0 or
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later, a lot of memory can be taken up with the
history palette and other features.  You can free up
this memory by selecting Edit>Purge>All from the
Photoshop menu.

Problem:  The preview seems broken.   It only
shows the checkerboard pattern.

Solution:  Sometimes the preview begins in a
transparent part of a layer.   The simple solution is
to keep dragging the preview until you reach the
area of the layer that contains opaque image data.

Problem:  Preview is filled with color and I can’t
see the effects.

Solution:  Make sure that the Preserve Transpar-
ency checkbox is not checked on the layer that
you are affecting.

Problem:  A filter makes the graphics program or
the entire computer crash or freeze up.

Macintosh Solution:  Make sure that you have
allocated enough memory to Photoshop.   The
default memory allocation may not be enough,
especially if you are working with print resolution
images.   You can increase the memory allocation
by exiting Photoshop and performing a Get Info on
the Photoshop program icon.

You might also have an extension conflict.   Cur-
rently there is a known conflict with the shareware
program Kaleidoscope and we recommend turning
that program off while using our filters (visit
http://www.kaleidoscope.com for a fix for this
conflict).   To determine whether you have an
extension conflict, restart your computer while
holding down the Shift key.   You may release the
Shift key after you see the message “Welcome to

Macintosh.   Extensions off.”  Then try the
same filter operation.   If it now works, then
you have a control panel or extension
installed in your computer that is incompat-
ible with Eye Candy 4000.   We will love you
very much if you try to identify the problem
extension and inform us about the conflict.

Windows Solution:  Make sure that you
have allocated enough memory to
Photoshop.   The default memory allocation
may not be enough, especially if you are
working with print resolution images.  With
Photoshop 5.0 or later, a lot of memory can
be taken up with the history palette and
other features.  You can free up this memory
by selecting Edit>Purge>All from the
Photoshop menu.

Also, make sure that your computer system
has the minimum requirements to run our
software.   You should also try exiting out
of other programs before you run
Photoshop, as there might be a conflict
between another program and Eye Candy
4000.   If you notice such a conflict, we will
love you very much if you try to identify
the problem program and inform us about
the conflict.
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License Agreement
This is a legal agreement between you (either an individual or an entity), the end-user, and Alien Skin
Software LLC.   By installing the computer software in this package (“SOFTWARE”), by loading or
running the SOFTWARE, or by placing or copying the SOFTWARE onto your computer hard drive, you
are agreeing to be bound by the terms of this Agreement.   If you do not agree to the terms of this
Agreement, promptly return the SOFTWARE and the accompanying items (including all written materi-
als), along with your receipt to the place from where you obtained them for a full refund.

ALIEN SKIN SOFTWARE LLC LICENSE

1.   GRANT OF LICENSE.   Alien Skin Software LLC grants to you the right to use one (1) copy of the
enclosed SOFTWARE on a single computer.   For purposes of this section, “use” means loading the
SOFTWARE into RAM, as well as installation on a hard disk or other storage device.   You may not:
rent, lease, modify, translate, disassemble, decompile, reverse engineer, or create derivative works
based upon the SOFTWARE.   The SOFTWARE, together with any archive copy thereof, shall be either
returned to Alien Skin Software LLC or destroyed when no longer used in accordance with this
Agreement, or when the right to use the SOFTWARE is terminated.

2.   COPYRIGHT.   The SOFTWARE is owned by Alien Skin Software LLC and/or its licensors and is
protected by United States copyright laws and international treaty provisions.   You must treat the
SOFTWARE like any other copyrighted material, except that you may either (a) make one copy of the
SOFTWARE solely for back-up or archival purposes, or (b) transfer the SOFTWARE to a single hard disk
provided you keep the original solely for backup or archival purposes.   You may not otherwise
reproduce, copy or disclose to others, in whole or in any part, the SOFTWARE.   You may not copy the
written materials accompanying the SOFTWARE.

3.   OTHER RESTRICTIONS.   This License Agreement is your proof of license to exercise the rights
granted herein and must be retained by you.   You may not rent or lease the SOFTWARE, but you may
transfer your rights under this License Agreement on a permanent basis provided you transfer this
License Agreement, the SOFTWARE, and all accompanying written materials and retain no copies, and
the recipient agrees to the terms of this Agreement.   Any transfer of the SOFTWARE must include the
most recent update and all prior versions.

4.   GENERAL PROVISIONS.   Should any provision of this Agreement be held to be void, invalid,
unenforceable or illegal by a court, the validity and enforceability of the other provisions shall not be
affected thereby.   If any provision is determined to be unenforceable, you agree to a modification of
such provision to provide for enforcement of the provision’s intent, to the extent permitted by appli-
cable law.   Failure of a party to enforce any provision of this Agreement shall not constitute or be
construed as a waiver of such provision or of the right to enforce such provision.   If you fail to
comply with any terms of this Agreement, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

LIMITED WARRANTY



LIMITED WARRANTY.   Alien Skin Software LLC and its licensors warrants that if properly installed and
operated on a computer for which it is designed, the SOFTWARE will perform substantially in accor-
dance with the accompanying written materials for a period of ninety (90) days from the date of
receipt.

CUSTOMER REMEDIES.   Alien Skin Software LLC and its licensors’ entire liability and  your exclusive
remedy shall be, at Alien Skin Software LLC’s option, either (a) return of the price paid or (b) repair or
replacement of the SOFTWARE that does not meet Alien Skin Software LLC’s Limited Warranty.   To make
a warranty claim, return the SOFTWARE to the point of purchase, accompanied by proof of purchase,
your name, your address, and a statement of defect, or return the SOFTWARE with the above informa-
tion to Alien Skin Software LLC.   This Limited Warranty is void if failure of the SOFTWARE has resulted
in whole or in part from accident, abuse, misapplication or violation of this Agreement.   Any
replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty
(30) days, whichever is longer.   This warranty allocates risks of product failure between Licensee and
Alien Skin Software LLC.   Alien Skin Software LLC’s product pricing reflects this allocation of risk and
the limitations of liability contained in this warranty.

NO OTHER WARRANTIES.   ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS DISCLAIMS ALL OTHER WARRAN-
TIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANY-
ING WRITTEN MATERIALS.   THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.   YOU MAY HAVE
OTHERS WHICH VARY FROM JURISDICTION TO JURISDICTION.   ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS
DO NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED, ERROR FREE OR MEET
LICENSEE’S SPECIFIC REQUIREMENTS.   THE WARRANTY SET FORTH ABOVE IS IN LIEU OF ALL OTHER EXPRESS
WARRANTIES WHETHER ORAL OR WRITTEN.   THE AGENTS, EMPLOYEES, DISTRIBUTORS, AND DEALERS OF
ALIEN SKIN SOFTWARE LLC ARE NOT AUTHORIZED TO MAKE MODIFICATIONS TO THIS WARRANTY, OR ADDI-
TIONAL WARRANTIES ON BEHALF OF ALIEN SKIN SOFTWARE.   ADDITIONAL STATEMENTS SUCH AS DEALER
ADVERTISING OR PRESENTATIONS, WHETHER ORAL OR WRITTEN, DO NOT CONSTITUTE WARRANTIES BY ALIEN
SKIN SOFTWARE LLC OR ITS LICENSORS AND SHOULD NOT BE RELIED UPON.

EXCLUSIVE REMEDIES.   You agree that your exclusive remedy against Alien Skin Software LLC, its
affiliates, contractors, suppliers, and agents for loss or damage caused by any defect or failure in the
SOFTWARE regardless of the form of action, whether in contract, tort, including negligence, strict
liability or otherwise, shall be the return of the purchase price paid or replacement of the SOFTWARE.
This Agreement shall be construed in accordance with and governed by the laws of the State of North
Carolina.   Copyright and other proprietary matters will be governed by United States laws and
international treaties.   IN ANY CASE, ALIEN SKIN SOFTWARE LLC AND ITS LICENSORS SHALL NOT BE LIABLE
FOR LOSS OF DATA, LOSS OF PROFITS, LOST SAVINGS, SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT
OR OTHER SIMILAR DAMAGES ARISING FROM BREACH OF WARRANTY, BREACH OF CONTRACT, NEGLI-
GENCE, OR OTHER LEGAL THEORY EVEN IF ALIEN SKIN SOFTWARE OR ITS AGENT HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.   Some jurisdictions do
not allow the exclusion or limitation of incidental or consequential damages, so the above limitation
or exclusion may not apply to you.

U.S.   GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS.   Use, duplication, or disclo-



sure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of
the Commercial Computer Software—Restricted Rights at 48 CFR 52.227-19, as applicable.   Contractor/
manufacturer is Alien Skin Software, LLC, 1100 Haynes Street, Suite Zero, Raleigh, NC 27604 USA.

The code for reading TIFF images in the Chrome filter comes from Sam Leffler.  Below is the permission
notice allowing us to use it.  Although he says his code can be used for free, we will hunt him down and
buy him a nice present.

Copyright (c) 1988-1996 Sam Leffler

Copyright (c) 1991-1996 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (i) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE  SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHER-
WISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA
OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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Credits:
Graphics Programming

Jeff Butterworth, Finley Lee

User Interface and System Programming
Finley Lee

System and Installer Programming
Sam Mauney

Project Management
Amedeo Rosa

Manual
Todd Morman, Skip Elsheimer, Dale Flattum

Eye Candy 4000 Logo and Artwork
Dale Flattum

Testing
Skip Elsheimer, Steve Graham (and a cast of hundreds)



89Color Page: The Color Gradient Editor

The Color Gradient Editor gives you precise control over color choices in Gradient Glow, Fire,
Smoke and Star; it is explained in detail in each of those filter chapters.

The white dots above the gradient determine how quickly the color and opacity drop off between
color stops.  They are placed at the midpoint between color stops as a default.  Notice how moving
the midpoint control between blue and yellow to the left increases the width of the blue area.

The opacity of each color stop can be adjusted from 0 to 100.   Above, we have selected the yellow
color stop (notice the solid black triangle) and have reduced the value of the Opacity slider,
producing a noticeably different effect.

 In the first row above, notice how the colors in the editor correspond to those in the Gradient
Glow and Star effects; the leftmost color stop determines the color at the center of the effect.
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Color Page: Fire and Smoke

At left, above, Smoke was applied with the Natural Spectrum box checked, yielding a
realistic, grayish smoke color.   At right, Smoke was applied with the Natural Spectrum box
unchecked; the “Pride” color gradient was used.  Smoky effects in a wide range of color
combinations are possible.

At left, above, Fire was applied with the Natural Spectrum box checked, yielding a realistic
flame color.   At right, Fire was applied with the Natural Spectrum box unchecked; the
“Blue Flame” color gradient was used.  Chemical fires and a wide range of odd flame effects
are easy to create.



91Color Page: Chrome and Glass

The three images above use the same reflection map with very different results.  The left image is a
standard Chrome with white highlights and zero Ripple Thickness.  The middle image uses a yellow Tint
Color with Tint Amount at 100 to create a golden effect.  The right image increases the Ripple Thickness
to add more distortion to the reflection map.

Chrome works by using uncompressed TIFF files as reflection maps to create metallic distortions.   Above
are examples of four of the reflection maps included with Chrome: Porch.tif, Running.tif, Brickwall.tif and
Shinypenny.tif.   You can also create and save your own TIFF files for use as reflection maps in Chrome.
Experiment away!

These Glass examples were all created on the same white polygon.  The left image shows a simple, rounded
bevel with a red tint.  The middle image is the same bevel but with a high value of Gradient Shading.  The
right image shows a grooved bevel.
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Color Page: Antimatter

The Antimatter filter inverts brightness values
without affecting hue or saturation.  Try applying
Antimatter to individual color channels, as well as
to the entire image, as demonstrated below.

Above, Antimatter was applied to all three color
channels.

Clockwise from top left, above: the original RGB
image; Antimatter applied to the Red channel;
Antimatter applied to the Blue channel, Antimatter
applied to the Green channel.

HSB Noise

The HSB Noise filter creates a range of colorful
texture effects.   This page demonstrates high and
low values of four of the sliders in HSB Noise,
isolated from other sliders to more clearly show
the effect.  The images below were created using
the Smooth Fractal option.

Low (left) and high (right) Opacity Variation.
Note the weave effect on an underlying layer
visible at the right.

Clockwise from top left: original image with low
variation settings for all sliders; high Hue Varia-
tion; high Saturation Variation; high Brightness
Variation.


